CHAPTER 1

Introduction to ILWIS for Windows
ILWIS is an acronym for the Integrated Land and Water Information System.
It is a Geographic Information System (GIS) with image processing capabilities.
ILWIS has been developed by the International Institute for Aerospace Survey and
Earth Sciences (ITC), Enschede, The Netherlands.
As a GIS package, ILWIS allows you to input, manage, analyze and present geographical data. From the data you can generate information on the spatial and
temporal patterns and processes on the earth surface.
Geographic Information Systems are nowadays indispensable in many different
fields of applications to assist in the decision making process. Most decisions are
influenced by some facts of geography. What is at a certain location? Where are the
most suitable sites? Where, when and which changes took place? Here are some
examples.
−

In land use planning, GIS is used to evaluate the consequences of different
scenarios in the development of a region.

−

In geology, GIS is used to find the most suitable places for mining, or to
determine areas subject to natural hazards.

−

Areas that may be affected by pollution are analyzed using GIS functions.
Extensions of cities are planned, based on analysis of many spatial and
temporal patterns, etc.

In order to be able to make the right decisions, access to different sorts of
information is required. The data should be maintained and updated and should be
used in the analysis to obtain useful information. In this process ILWIS can be an
important tool.
This chapter is intended to introduce you to ILWIS, and specifically to the user
interface. You will learn how to start ILWIS, the functions of the Main window,
and how to open maps and tables.
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1.1 Starting ILWIS
To start ILWIS for Windows, double-click the ILWIS program icon in the ILWIS
program group. After the opening screen you see the ILWIS main window (see
figure 1.1). From this window you can start all operations and select all data.
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Figure 1.1: The ILWIS main window (in Window 3.1)

There is a possibility that the Catalog part of the main window on your screen does
not look exactly the same as shown in figure 1.1. This may be due to the fact that
during the installation of ILWIS you decided to copy the data files to a directory
other than the standard start-up directory c:\ilwis21\data.
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The Catalog
If you are in the correct directory c:\ilwis21\data you will see at the right hand side
of the main window, the maps and tables of the Cochabamba data set, used for the
ILWIS Beginner’s Guide. This part of the main window, in which maps, tables
and other objects in the working directory are displayed, each with its own type of
icon, is called the Catalog.
In the Catalog the following icons are used for maps and tables:
for raster maps (for example Tmb1);
for polygon maps (for example Landuse);
for segment maps (for example Contour);
for point maps (for example Rainfall);
for tables (for example Rainfall).
Before continuing with this exercise you first need to change to the subdirectory
c:\ilwis21\data\usrguide\chap01, where the data files for this chapter are stored.
To change the current drive and working directory, you can use the navigator:
Change drive: to select a different drive.
Change directory: to select a different directory.

F
•

Change the working drive and the working directory until you are in
the directory c:\ilwis21\data\usrguide\chap01 or elsewhere your
hard disk where the data of this chapter is stored.

The Catalog shows all maps and tables needed for this chapter.
However, there are many more ILWIS objects used than just maps and tables. In
order to show all objects in the data directory you first have to customize the
Catalog.

Customize Catalog button: to select the object types to be shown in the
Catalog.
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F
•

Click the Customize Catalog button. A dialog box is displayed
titled Customize Catalog, and you see a list of objects that are used
in ILWIS. Only maps and tables are selected.

•

Select all objects: click the one at the top of the list and move down
while you keep the mouse button down; then, release the left mouse
button. Click OK when finished.

Now all the objects required for the exercises of chapter 1 are displayed by a name
and an icon in the Catalog. The following objects can be seen, most of which are
related to the area surrounding the city of Cochabamba in Bolivia:
Cochabam
A coordinate system, containing the definition of the coordinate system (the
minimum and maximum coordinates and the map projection) used for the maps of
the Cochabamba area;
Landuse
A domain, explaining the content of the units in the land use map and table;
Landuse
A polygon map containing land use units of the area surrounding the city of
Cochabamba in Bolivia;
Landuse
A representation, containing the color assignments of the map units in the land use
map;
Landuse
An attribute table containing information on the land use units;
View3d1
A domain, explaining the content of the raster map View3d1;
View3d1
A raster map, containing a picture of a three dimensional view of the study area;
View3d1
A representation, containing the color assignments of the pixels in the raster map
View3d1.
View3d2
View3d2
View3d2
A domain, raster map and representation, of another picture View3d2.
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The functions of the various objects and their relationships will be demonstrated in
chapter 2.

F
•

Position the mouse pointer on a map or table, for example on polygon
map Landuse. A description of this map will appear on the Status
line.

•

Click the right mouse button on a map to get a Context-sensitive
menu.

A context-sensitive menu is a menu which is different, depending on where you are
in the program. For example, if you open one on a polygon map, it only shows
those operations which can be applied on polygon maps. Context-sensitive menus
are obtained by clicking the right mouse button.
The operations-list
Let us concentrate again on the different parts of the ILWIS main window. On the
left, there is a list of GIS and image processing operations and other tools, called
the Operations-list.

F
•

Position the mouse pointer on one of the operations in the Operationlist, for example AttriRas.

When the mouse pointer is positioned on an operation, the status line at the bottom
of the main window, shows a short description of that operation.

F
•

Click with the right mouse button on some operations and select
Help to get a short explanation of the operation in a pop-up. When
you click somewhere else on the screen, the pop-up disappears.

•

You can close the large Help window by clicking File and Exit.

Menu bar
At the top of the main window, are the menu bar, the command line, and button
bar. The menu bar can be used to select all operations, to change the contents of the
Catalog and to access the ILWIS Help.

ILWIS User’s Guide

5

Introduction to ILWIS for Windows

F
•

Click Operations in the menu bar. The Operations menu is opened.
The Operations menu contains commands for all ILWIS operations,
which are grouped. The triangles to the right of the commands on a
menu indicate that there is another (cascading) menu.

•

Click Visualization. The cascading menu appears.

•

Select the Show Map command. The Show Map dialog box is
opened. In a dialog box you can select the input maps for an
operation (among other things).

•

Close the Show Map dialog box by clicking Cancel.

•

Open the Help menu.

Getting help

F

The ILWIS on-line help allows you to obtain help information from any point
within the program. The Help menu contains the following options:
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−

Help on this window. You obtain Help on the current window. Depending on
the window from which you select this Help option, you can get help on the
main window, the map window, the table window or the pixel information
window, etc.

−

Contents. The Contents page of the ILWIS Help is displayed. By clicking the
links and using the buttons at the top of the Help window, you can go to any
Help topic you like.

−

Search. This opens the Search dialog box. Select the item (or type some
characters of the key word on which you want to obtain help). Subsequently,
click the Show Topics button in this dialog box, select the topic you want in
the lower list box, and then click the Goto button.

−

Index. The Index page of the ILWIS Help is displayed. Click any link to get
help.

−

Glossary. The ILWIS Glossary is displayed, which contains a list of important
ILWIS terms. Select any term in the Glossary and you get a short description of
this term.

−

Operations. This opens the ILWIS Operations Help, containing help on
ILWIS operations, which are ordered in the same way as in the Operations
menu.
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−

Menu commands. This opens the ILWIS menu commands Help, containing
information on the menu structure of ILWIS.

−

How to.... This opens the How to... Help topic. Select any How to... topic and
obtain a short explanation on which commands you have to use to achieve a
certain goal.

−

How to Use help. Opens a Windows Help topic which explains you how the
windows Help program works.

−

About ILWIS. Opens a small window containing information on the ILWIS
version, your license number, and a list of the ILWIS team.

F
•

Select the command Help on this window from the Help menu. The
ILWIS Help is opened on the contents page.

•

Click the link Introduction. The Help displays the topic Main
window: introduction, in which all parts of the main window are
explained.

•

Click anywhere in the picture of the main window in this Help topic.
A pop-up appears explaining you more.

•

Use the browse buttons (<< and >>) at the top of the window to go
page by page through the Help.

•

Practice a bit more with the ILWIS Help. When you have finished,
close the Help window by double clicking the Control-menu box (in
the upper left corner).

The command line
You will go back to the main window to see two more items.
The command line can be used to type commands or calculations. When you
perform a certain operation in ILWIS, you will see the corresponding expression
displayed on the command line. The command line allows you to do calculations
with maps, which is in fact the backbone of the ILWIS system. In chapter 7 to 12
you will learn to work with the command line in map calculation statements, and
also to use it as a short cut.
The button bar
Other short cuts for performing the most frequently used operations are provided by
the button bar. The button bar of the main window contains the following buttons:
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Hide/Show Operations-list button: to hide or show the Operations-list in
the main window.
Show Map button: to open a raster, segment, polygon or a point map in a
new window.
Show Table button: to open a table in a new table window.

Show Pixel Information button: to open the pixel information window.

Customize Catalog button: to select the object types to be shown in the
Catalog.
Summary: the Main window of ILWIS
When you start ILWIS, the first thing you will see after the opening screen is the
Main window. From this window you can start all operations and select all data.
The Main window contains the following items:
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−

The Catalog provides an overview of available ILWIS objects in the current
directory and offers a tree structure for other directories and other disk drives.

−

The Operations-list provides an overview of ILWIS operations. Each operation
is preceded by an icon; the icon indicates the output data type of the operation.
Further, the Operations-list contains New commands to create new objects,
and Show and Edit commands, to show/open or edit an object.

−

The command line can be used to type commands or calculations.

−

Buttons in the button bar provide short cuts for regularly used menu
commands.

−

The navigator allows you to select another directory or another drive.

−

The status line gives a brief explanation on the items (objects, buttons, menu
commands, operations etc.) when moving with the mouse pointer over the
item.

−

The menu bar can be used to select all operations, to change the contents of the
Catalog and to access the ILWIS Help.

−

The ILWIS on-line Help allows you to obtain help information from any point
within the program.
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1.2 Displaying geographic data
Geographic data are organized in a geographic database. This database can be
considered as a collection of spatially referenced data that acts as a model of reality.
There are two important components of geographic data (figure 1.2): its geographic
position and its attributes or properties. In other words, spatial data (where is it?)
and attribute data (what is it?) are distinguished. In the example of figure 1.2, you
can see that we have a (very simplified) map on one side and a table on the other.
Maps are considered spatial data, since the information they contain is directly
related to certain locations on the earth’s surface. The location of the units A, F and
G are specified with respect to their X and Y coordinates.
Tables, on the other hand, do not contain direct information on a location. They
contain descriptive information; in this case the names of the land use types and the
value of the land in monetary units. If we would only have the table, the data would
not be useful, since we don’t know where the units are located. If we would only
have the map, we still don’t know anything more about the units. In a Geographic
Information System like ILWIS, the link between spatial and attribute data is the
key to get real information. Only by combining them we can get answers to
questions such as: Where are the land use units with a value more than 250?

Figure 1.2: Spatial and non spatial data in ILWIS

In the following pages we will show you how to display spatial and attribute data in
ILWIS. We will introduce you to ILWIS map windows and you will practice
displaying a map. The map to be displayed is the polygon map Landuse which
shows the different land use types in the Cochabamba area in Bolivia. This map
was digitized from a paper map. A polygon map is a vector data object containing
closed areas and the boundaries making up the areas, which in this case represent
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land use units. In chapter 2 there will be a more detailed explanation about polygon
maps.

F
•

Double-click the polygon map Landuse in the Catalog.

ILWIS dialog boxes
This opens the Display Options - Polygon Map dialog box (see figure 1.3).
A dialog box allows the user to enter the information required by ILWIS to carry
out an operation. Dialog boxes are different depending on the application you are
performing. The dialog box which is displayed now is used to specify how you want
to display a polygon map. In general, a Windows dialog box can have features such
as:
Title bar. Shows the name of the dialog box and can be used to move the dialog
box on the screen. In this case the title is: Display options - Polygon Map.
Text box. A small box which can be used for typing text. The dialog box shown on
your screen contains a text box in which you can specify the width of the boundary
lines of the land use units.
Drop-down list box. A small box with an arrow button which allows you to select
items. A list, including the available data, will be displayed when the arrow button
or box is clicked. The button on the right hand side is the Create button. The
create button can be used to create an object when the list excludes a proper object.
When you click the create button, the program proceeds to a new dialog box.
The dialog box in figure 1.3 contains two list boxes: one in which you can specify
the color of the boundary lines of the land use units, and another in which you can
indicate the color of the units themselves. These colors are stored in an object called
representation.
Check box. This is a small square in the dialog box which allows you to select or
clear an option.
figure 1.3 contains four check boxes. When you select the Info check box, you will
be able to read information about the meaning of the land use units, once the map is
displayed. The second box Mask allows you to selectively display some land use
types. If the third box, Boundaries only is selected, only the boundaries of the land
use units will be shown. The fourth box, Attribute, can be selected if you want to
display an attribute value from a table connected to the map, instead of the land use
units themselves.

10

ILWIS User’s Guide

Introduction to ILWIS for Windows
Command buttons. Used to initiate an action. The OK, Cancel, and Help are
common command buttons which are located on the right hand side in an ILWIS
dialog box.
OK button: whenever you click the OK button (or press Enter) the dialog box is
closed and the action will be executed.

Cancel button: when you click the Cancel button (or press Esc) the dialog box is
closed and the action is canceled.

Help button: when you click the help button (or press F1) context-sensitive Help
information will be displayed (which means Help dealing with the specific dialog
box).
Option buttons. Option buttons can be seen as circles and represent a group of
mutually exclusive options. The selected option button contains a black dot. You
can select one option at a time. Selecting another option button, clears the other.

Figure 1.3: The dialog box Display Options - Polygon Map (in Windows 3.1)
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!

You can move through the various options within a dialog box by using the
Tab key or the Shift+Tab keys on the keyboard.

As you can see, ILWIS gives suggestions for this in the dialog box, which are called
the defaults.

F
•

Select the check box Boundaries Only. Now you will see that the
contents of the whole dialog box changes. If you only want to show
the boundary lines of the units, no input is needed anymore on how
you want to display the units themselves. The contents of the dialog
box depends on the input of the user. That is why we call it contextsensitive.

•

Select the list box Boundary Color. You will see a list with all
different types of colors that you can select.

•

Practice some more with different options in the dialog box and the
Help button. After that, change all options again so that they are the
same as in figure 1.3. Then confirm your input by clicking the OK
button or pressing <Enter>.

A map window
The polygon map Landuse is displayed in a map window on the screen (see figure
1.4). All maps in ILWIS are displayed in a map window. It has many similar
features as the main window of ILWIS, which we have seen before, with the
exception of the map viewer (the central part where the actual map is displayed),
and the button bar.
Button bar: consists of buttons that provide short cuts to zoom in or out, or to
display the entire map. The buttons in the button bar of a map window have the
following functions:
Displays the entire map in the map window.
Zooms in on a selected spot or area on the map.
Zooms out by the scale factor 2.
Enlarges the map window by a factor 2.
Reduces the map window by a factor 2.
12
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Redraws the contents of the map window.
Measure the distance between two selected locations (in meters) and the
direction (in degrees) in respect to the North.

Maximize button
Minimize button
Title bar
Menu bar
Control-menu box

Button bar

Status line

Map viewer

Figure 1.4: The ILWIS map window

F
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Click the Zoom in button in the button bar.

•

Position the mouse pointer where you want to zoom in on the map.
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•

Press the left mouse button, hold it down, and move the mouse
pointer to another position to define the area to zoom in (dragging).
Then release the left mouse button.

•

Click the Zoom out button to reduce the map.

•

Click the Entire map button to display the entire map.

To increase or decrease the size of the map window by a factor 2:

F
•

Reduce the map window by clicking the Smaller button

.

•

Enlarge the map window by clicking the Larger button

.

•

Maximize the map window by clicking the Maximize button

.

When the size of the screen does not allow anymore for an enlargement of 2, the
enlarge button is not visible in the button bar: it is grayed out.
You will now pay more attention to another part of the map window: the status
line, which you can find below the map viewer. If you move with the mouse pointer
over the map, you will see that the status line displays the position of the mouse
pointer in the map. To specify the position in an absolute way a coordinate system
is used. There are many different coordinate systems in use around the world.
Coordinates can be displayed in two ways:
− as geographic coordinates (latitude, longitude), or as
− metric coordinates (X,Y)
The status line displays the coordinates in meters and/or geographic coordinates.
First the X Y values of metric coordinates are given, followed by the degrees,
minutes and seconds of the latitude and longitude.

F
•

Move the mouse pointer through the map and verify in the status line
that the X values decrease when going to the left of the map (towards
the West), and the Y coordinates decrease when going to the bottom
of the map (towards the South).

•

Try to locate the mouse pointer on the following X and Y
coordinates:
X= 803384, and Y= 80748777, and find the corresponding
latitude and longitude.

With the measure distance button it is easy to measure the distances and the angle
between two points.
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F
•

Click the Measure Distance button on the button bar of the map
window.

•

Locate the mouse pointer on a point in the map, and press the left
mouse button. Move to another point, while keeping the left mouse
button pressed.

•

When you release the mouse button, a window will show with the
distance between the two points, and the direction of the line
connecting the points.

The use of a coordinate system is further discussed in the next chapter.
The contents of the map: domain
So far you have only looked at the different units of the map, but you do not know
yet what they represent. You can obtain information on the map contents simply by
pressing the left mouse button on any of the colored units in the map.

F

Domain

•

Press the left mouse button on different units in the map to find out
what they represent.

•

Find the land use class at the location: X = 801830 and Y=
8089283.

As you can see, the units of the land use map are described by classes, with names
such as Forest Grassland, Bare rock, Lake, etc. The list of all class names
that can occur in a map is called in ILWIS a domain. A domain defines what is the
possible contents of a map, a table, or a column. In other words, what do these
items in a map, table or column mean? Are they classes (such as land use classes),
or values or something else? The domain concept is very essential in ILWIS 2.1,
and we will therefore come back to it in chapter 2. The full list of class names of
the land use units can be obtained by opening the domain.

F
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•

Activate the main window (click a visible part of it, or if it is not
visible, click the Control-menu button in the upper left corner of the
map window and select ILWIS).

•

Double-click the domain Landuse in the Catalog of the main
window.
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The Domain Editor is opened. The title bar reads Landuse: landuse units. As
you can see, the domain lists all possible class names of the map: it is simply a list
of all land use types which can occur in the map. Since these are different classes,
we speak of a Class domain. In chapter 2 you will also see other domain types.

F
•

Close the Domain Editor.

We started this lesson by explaining the difference between spatial and non-spatial
(or attribute) data. From the map window, we can also obtain information on
attributes, related to the different land use units of the map which is displayed.

F
•

Double-click a unit in the map.

Now you will see a small window appearing with the title Edit attributes. Inside
the window you will see two lines. The first line contains the land use class name of
the unit you clicked, and the second line contains the word Landvalue followed
by a number: the average monetary value of this land use type. The Landvalue
information is a line from an attribute table Landuse, which is linked to the map.
Let us look now in more detail to tables, but first close the map window.

F
•

Close the map window by clicking the Control-menu box (upper left
corner) and select Close. You can do the same by double-clicking the
Control menu box.

A table window
We will finish this chapter by showing you how to display attribute data.

F
•

Double-click the table Landuse in the Catalog.

The table Landuse is now displayed in a table window (see figure 1.5).
The table contains two columns. The left column in gray color, has no header. If
you look closely to the names in this left column you will remember that those are
the names that you have seen also in the map Landuse. This is again the domain,
which can not only define the contents of a map, but also the contents of a table.
16
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As you can see from figure 1.5, a table window contains many of the features we
have already seen in the map window. We only mention here the following ones:
Data viewer: where the tabular data is displayed. It contains columns, records
(rows) and fields (intersection of columns and records).
Column name button: each column has a name which is displayed on the upper
gray button above the column. Click this button to select the entire column. Doubleclick this button to view or change the properties of the column.
Command line: to perform calculations by typing in a calculation formula or an
expression.
Record buttons: the gray buttons in the left column of the table which can be used
to switch between Table View and Record View. When you click any record
button, the data of that record is displayed. If you click the Switch View button
(the upper left gray button with no name), you will see the Record View of the first
record. Then click the Switch View button to view the table again.
Next to the left gray column, which contains the domain items, the table has one
more column, called Landvalue, which is an attribute column containing the
average value of the land in fictive monetary values. As you can see, this column
contains values.

Change column properties button

Command line
Title bar

Menu bar

Minimize button
Maximize button

Control-menu box
Record view button

Scroll bar

Record view buttons

Status line

Data viewer

Figure 1.5: An ILWIS table window
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F
•

Double-click the Column button with the name Landvalue on it.

The Column properties dialog box appears. This dialog box contains all
information on column Landvalue. The dialog box shows for instance the
domain of this column: Default Value domain. The next line gives the range of
values in this column: between 0 and 1000. The actual values in the column are
also shown: between 50 and 1000.

F
•

Click the Cancel button to close the Column Properties dialog box.

You will now practice with the various items related to the display of tables. First
we will show you how to switch between Table View (in which you will see the
table ordered in such a way that the information of one record is displayed in
different columns) and Record View (in which you will see only the information
related to one record):

F
•

Click the Switch View button (the upper left gray button in the table)
to display only the data of the first record.

The displayed table now represents the information of one record only, i.e. the first
record or another record depending on which button you clicked. At the top of this
window there are forward (> 1 record and >> 10 records) and backward (< and <<)
buttons which are used to go to the next or previous records.

F
•

Click the forward (> and >>) buttons to go to next records.

•

Click the backward (< and <<) buttons to go to previous records.

•

Click the Switch View button (the upper left gray button) to switch
back to table view.

By default, data in a table are sorted on the domain of the table. The records of a
table can also be sorted on one of the columns in the table. The Sort operation is
only for display purposes, as the original ordering of the columns will remain
unchanged.
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F
•

Open the Columns menu and select the Sort command.

The Sort dialog box is opened. By clicking the option Column in this box, a
column can be selected for sorting the table.

F
•

Select option Column, and select column Landvalue from the list
box. Then click the OK button.
Now the table is ordered according to the values in the column
Landvalue.

•

Resort the table using the sort option: Domain.

In chapter 5 many more options of the table window are treated. For now close the
table.

F
•

From the File menu, select Exit or double-click the Control-menu
box of the table window.

Summary: displaying maps and tables
In this section you have learned:
−

How to use dialog boxes: How to enter parameters to define the way in which a
map is displayed.

−

The basics of a map window: How to open a map, the different components of
a map window: title bar, menu bar, button bar, status line, map viewer. How to
zoom in and out. How to enlarge or reduce a map window. How to read the
coordinates of a map: coordinate system. How to know the contents of a map:
domain.

−

The basics of a table window: How to open a table. The different components
of a table window: title bar, menu bar, button bar, table viewer, command line.
The fact that contents of a table are defined by the domain of the table. The fact
that columns also have a domain. The display of entire tables, or of records.
How to sort a table.
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1.3 The Cochabamba area
Before we continue with a more detailed look at the main concepts of ILWIS in the
next chapter, it is maybe good to introduce you also to the study area, from which
most of the data for this ILWIS User’s Guide are taken: the Cochabamba area.

F
•

Double-click the map View3d1. The Display Options dialog box
is opened.

•

Click OK.

The picture which is displayed is a three dimensional view of the Cochabamba
area. This picture was made by the Display3D operation which will be treated in
chapter 10, using a Digital Elevation Model and a false color composite, derived
from Landsat TM bands

F
•

Zoom in on the right-hand side of the picture (Cochabamba city).

•

If you keep the left mouse button pressed while moving over the left
margin in the enlarged section, the image scrolls to the left.

Cochabamba city is a fast growing center with a population of approximately
300,000. The city is located in the Andean region of Bolivia, at an elevation of
about 2600 meters above sea level. It is located in a large valley, bordered on the
northern side by steep mountains, rising up to an elevation of 4500 meters. The
northern part of the city is located on the alluvial fans at the foot of the mountains.
Due to the high-intensity rainfall in the period November-January, the mountain
area is subjected to landslides and soil erosion, and the city itself occasionally
suffers from flashfloods on the alluvial fans. These processes affect the local
farmers, and also hinder the expansion of the city. An organization, PROMIC, has
been initiated to improve watershed management in the region.
A more detailed 3-D view of the city of Cochabamba itself, made from a scanned
airphoto, is also available.

F
•
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Close the picture View3d1, and open the picture View3d2. Have a
look at it, and close it when you have finished.
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